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Al recibir el producto 

Antes de la utilización, verifique si hay piezas sueltas o daños que se hayan 
producido durante el transporte. Si los hubiera, existe la posibilidad de un riesgo 
para la seguridad, NO intente utilizar el equipo. Favor de comunicarse con 
Megger lo antes posible. 

 

Equipo de Prueba – Ohmímetro para Transformadores MTO210 
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1  
Para conocer el MTO210 

Descripción General del Producto  

El Ohmímetro para Transformadores de Megger es un instrumento portátil para 
uso in situ, alimentado desde la línea eléctrica, diseñado específicamente para 
medir la resistencia de CD de todo tipo de arrollamientos magnéticos de manera 
segura y exacta. 

Su uso primordial es la medición de la resistencia de CD de todo tipo de 
arrollamientos de transformadores dentro de las gamas de corriente y resistencia 
definidas. También puede emplearse para probar arrollamientos de máquinas 
rotativas y realizar mediciones de resistencias de baja corriente en conexiones, 
contactos y circuitos de control. 

Cuatro características se combinan para hacer que este instrumento sea único: 
doble medición e inyección de corriente, prueba de cambiadores de toma bajo 
carga, descarga automática y desmagnetización. 

Las dos entradas de potencial permiten medir simultáneamente la resistencia de 
los arrollamientos primario y secundario de un transformador monofásico o 
trifásico. La característica de lectura dual  acelerará la medición cuando los 
conductores de corriente alimentan más de un arrollamiento. 

El Ohmímetro para Transformadores es de suma utilidad para probar los 
arrollamientos y la resistencia de contacto de los cambiadores de toma, con 
contactos de derivación  previos al  cambio y reguladores de tensión. Una luz de 
advertencia destellará y el circuito interno de parada se disparará si los contactos 
de los cambiadores de toma presentan un episodio de corte de corriente antes del 
cierre. A través de esta acción se verifica la presencia de contactos desgastados o 
desalineados y brinda una indicación en caso de presentarse.    

De modo similar, los usuarios están protegidos por la función de seguridad del 
circuito de parada: en caso de desconexión involuntaria de un conductor de 
prueba o pérdida de alimentación del instrumento, la energía almacenada dentro 
del ejemplar que se prueba se descargará de manera rápida y segura. 

El MTO210 cuenta además con una función post-prueba. A la finalización de 
una prueba de transformador, se puede ejecutar la función de desmagnetización 
que ofrece el instrumento. Esta función realizará ciclos de desmagnetización a 
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través del transformador con corriente DC alternante . Luego de finalizados 8 
ciclos, el núcleo del transformador queda desmagnetizado. 

La amplia gama de resistencias (desde 1 micro-ohm hasta 1999 ohms) del 
Ohmímetro para Transformadores brinda un elevado grado de resolución 
incluso para la menor resistencia de arrollamiento bajo prueba . 

Entre las funciones se cuentan las siguientes: 

 La lectura digital directa permite ganar tiempo, no se requiere compensación 
manual. 

 El circuito de descarga incorporado descarga de manera segura el 
transformador cuando se finaliza la prueba, si el conductor se desconecta 
accidentalmente o si se interrumpe la alimentación. 

 El indicador luminoso de prueba brinda una indicación visual de un ejemplar 
cargado o descargado, incluso si se interrumpe la alimentación del 
instrumento. 

 Dos canales de medición independientes permiten la prueba simultánea de 
arrollamientos primarios y secundarios o la medición de dos fases a la vez. 

 Los circuitos sensibles de prueba de cambiadores de toma verifican el 
funcionamiento de los contactos de los cambiadores de toma bajo carga, de 
modo que la secuencia de cierre antes del corte se realice correctamente. Si se 
presenta una situación de circuito abierto, el instrumento se desactiva 
inmediatamente. 

 La alimentación de corriente patentada, generada electrónica y 
reguladamente, permite resolver rápidamente el inconveniente de los 
transformadores de alta inductancia, facilitando la rápida realización de 
mediciones. Las mediciones se muestran en pantalla sólo luego de que 
la corriente de prueba se estabiliza.      

 La amplia gama de resistencias es adecuada para la prueba de una gran 
variedad de transformadores. 

 El modo de rampa ascendente de corriente permite probar continuamente la 
tensión de prueba y establecer la corriente máxima sobre la base de la carga 
de prueba específica. 

 Liviano y portátil, el MTO es ideal para su uso en ambientes de taller o 
subestaciones. 

 La protección contra sobretemperatura causa un corte automático de 
corriente y brinda una indicación para evitar daños al instrumento. 

 Cumple con los requisitos de las Directivas Europeas de EMC y de Baja 
Tensión. 

Se recomienda que el usuario se familiarice con el MTO antes de efectuar una 
conexión a un transformador.  
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 Controles del Panel Superior 

 

Figura 1: Panel Frontal del MTO210 

 

Módulo de Alimentación de CA de Entrada: 

Este módulo es una interfaz IEC320 a la alimentación eléctrica de la red. El 
módulo tiene un interruptor integrado, portafusibles y módulo de filtro de entrada. 
Arriba de este módulo se indica la tensión, frecuencia y potencia requeridas para 
el producto. Debajo del módulo se indica el tipo de fusible y la capacidad nominal 
en función de la tensión de entrada que se emplea. La luz verde ubicada del lado 
derecho del módulo se ilumina cuando el equipo está encendido (ON).   

0, posición apagado - OFF   

| , posición encendido - ON   

 

Terminales de Corriente de Salida 

Estas conexiones se utilizan para conectar al o a los arrollamientos del 
transformador y transferir la alimentación en CD al arrollamiento del transformador 
para ejecutar funciones de prueba y desmagnetización. La conexión puede 
suministrar una tensión de prueba hasta 50 V CD y hasta una corriente de 10 A. 
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Tensión de Entrada V1 

Estas conexiones se utilizan para conectar un arrollamiento de un 
transformador para la medición de la tensión de entrada. El instrumento 
calculará automáticamente la resistencia de esta entrada en combinación con la 
fuente de corriente. Los conectores se utilizan también como camino para que 
la corriente circule durante las descargas. Los conductores de tensión se 
utilizarán siempre conjuntamente con los conductores de corriente. 

 

Tensión de Entrada V2 

Estas conexiones se utilizan para conectar un segundo arrollamiento de un 
transformador para la medición de la tensión de entrada. El instrumento 
calculará automáticamente la resistencia de esta entrada en combinación con 
la fuente de corriente. Los conectores se utilizan también como camino para 
que la corriente circule durante las descargas. Los conductores de tensión se 
utilizarán siempre conjuntamente con los conductores de corriente. 

 

Terminal de Tierra/Masa 

Esta conexión se utiliza para conectar a tierra un transformador en prueba, 
para mayor seguridad. El transformador y el MTO deberán estar al potencial 
de la tierra de la fuente de alimentación cuando estén funcionando. 

 

Interruptor de Parada de Emergencia 

Al pulsarlo, este interruptor desactivará la alimentación eléctrica y descargará 
automáticamente el transformador. El instrumento está supervisando  
continuamente este interruptor en caso de que se produzca una emergencia. Si 
el interruptor está activado, no podrá comenzarse ninguna prueba. 

 

Interruptor de Regulación de Corriente 

Este interruptor se utiliza para controlar la cantidad de corriente que el 
instrumento empleará para probar un transformador.  

La posición  representa el máximo nivel de salida de la corriente de prueba. 

 

Conector de Baliza de Advertencia 

Cuando la Baliza de Advertencia está fijada al conector, el usuario tendrá una 
indicación más visible del modo de activación del MTO. 

 

INDICADOR de Corte Antes del Cierre  

Durante la prueba, la unidad indicará interrupciones en el flujo  de corriente. 
Durante la prueba de cambiadores de toma bajo carga, esta indicación significará 
que se ha producido una situación de corte antes de cierre defectuosa. 

 

Interfaz USB 

No es accesible en este momento 
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Entrada para Mantenimiento 

Por esta entrada se realizan actualizaciones de software y diagnósticos. El panel 
de la interfaz puede quitarse y se accede así a una conexión Ethernet que permite 
acoplar el instrumento de manera externa a una PC. Esta entrada NO es 
compatible con una red. Este producto no está previsto para su uso en red.     

 

Conexión RS232 

Esta conexión se emplea para instalar una impresora térmica de 4” y/o para 
transmisión de datos desde el MTO a una PC de usuario.   

 

Interruptor de Control a Distancia 

Con este conector se efectúa la interconexión con un interruptor a distancia. 
Este interruptor se emplea principalmente cuando el sistema se utiliza para 
probar un cabiador de tomas bajo carga.  

El Interruptor de Control a Distancia puede iniciar la prueba del MTO a 
distancia y guardar múltiples lecturas de resistencias para los cambios de 
toma. La función de almacenamiento en el modo a distancia es secuencial y 
se ejecuta durante una prueba continua de resistencia. La unidad almacenará 
también en una memoria local los episodios de corte antes del cierre. 

 

Conexiones de Bloqueo 

Estas conexiones se utilizan en caso de que las pruebas requieran 
mecanismos de bloqueo desde el transformador. Si la conexión de bloqueo 
está abierta, la unidad no podrá pasar al Modo de Prueba. Si el bloqueo se 
corta durante la prueba, la unidad se detendrá automáticamente y descargará 
el transformador que está activado. Se inhibirá realizar otras pruebas. 

Interruptor Modo  
de Salida de Datos    

 

El MTO imprimirá y guardará datos 

 
El MTO guardará datos 

 
El MTO imprimirá datos 

El MTO sólo mostrará datos 

 

 

Interruptor Modo de 
Función 

 

El MTO está en el Modo de Prueba 

 
El MTO está en el Modo de Revisión de 
Almacenamiento 

 El MTO está en el Modo de Configuración de Fecha y 
Hora 

 
El MTO está en el Modo de Selección de Formato de 
Datos 
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ESTADO INACTIVO - Al pulsar el botón, la unidad 
iniciará una prueba en un transformador. Esto ocurrirá 
sólo si el instrumento está en el Modo de Prueba (ver 
Interruptor de Modo de Función mostrado 
anteriormente). 

El INDICADOR DE PRUEBA ubicado arriba del botón 
se iluminará durante la prueba.    

ESTADO DE PRUEBA – Al pulsar el botón, la unidad 
detendrá una prueba en un transformador, y mantendrá 
los resultados en la pantalla. Guardará y/o imprimirá los 
resultados, conforme al Interruptor de Modo de Salida 
de Datos.  

 

Al pulsar el botón se detendrá la prueba y se descargará 
el transformador. El INDICADOR DE DESCARGA 
ubicado a la izquierda se iluminará durante el ciclo de 
descarga. 

 

Al pulsar el botón, se efectuará la desmagnetización de 
un transformador. El INDICADOR DE DESMAG 
ubicado a la derecha se iluminará durante el ciclo de 
desmagnetización. 

 

Al pulsar el botón, la unidad acusará recibo del ingreso 
de datos y mensajes mostrados, y durante el modo de 
prueba guardará los datos que se presenten en la 
pantalla.  

 

El símbolo indica que el botón  IMPRIMIRÁ los 
resultados de las pruebas por la salida RS232 cuando 
se lo pulsa con el aparato en el Modo de Revisión de 
Almacenamiento. 

En el Modo de Prueba y con indicación de “Ready”, el 

botón  cambiará la sensibilidad de la detección de 
transición de corriente. La posición predeterminada es 
desactivado (Off). 

 

El símbolo indica que el botón  dará al usuario la 
posibilidad de ELIMINAR la última prueba registrada en 
la memoria. Si se pulsa por segunda vez, la unidad dará 
al usuario la posibilidad de eliminar todas las pruebas de 
la memoria. Si se pulsa por tercera vez, la unidad ya no 
estará en la función eliminar.    

En el Modo de Prueba y con indicación de “Ready”, con 

el botón  se hará alternar la pantalla del OHM2 entre 
las posiciones activado y desactivado (ON/OFF). 
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2  
Seguridad 

La seguridad es responsabilidad del usuario 

El sistema MTO deberá ser maniobrado sólo por operadores calificados y 
capacitados. El operador debe leer y comprender este Manual de Instrucciones 
en su totalidad antes de utilizar el equipo. El operador debe seguir las 
instrucciones del presente Manual y prestar atención al equipo mientras éste está 
en uso. En caso de mal funcionamiento del equipo, la unidad deberá 
desconectarse inmediatamente y ser enviado devuelta a Megger para su 
reparación.  

“Las precauciones de seguridad que aquí se indican no tienen por objeto 
reemplazar los Procedimientos de Seguridad de su empresa. Para mayor 
información, remitirse por ejemplo a las normas IEEE 62-1995/IEEE C57.152 
and IEEE 510 - 1983, Prácticas de Seguridad Recomendadas por el IEEE para la 
Seguridad en Pruebas de Alta Tensión y Alta Potencia”.   

F 
ADVERTENCIA 

Al aplicar corriente a un transformador con inductancia muy 
elevada, debe tenerse cuidado de no quitar los conductores de 
corriente o tensión mientras la corriente todavía está circulando. 
Esto hace que se genere una tensión sumamente alta por el 
punto donde la corriente se corta. En ciertas condiciones, esta 
tensión podría ser letal.  

El Ohmímetro para Transformadores Megger cuenta con una protección de 
seguridad incorporada a través de los CONDUCTORES DE TENSIÓN. Los 
conductores de tensión deberán estar siempre conectados en paralelo con los 
conductores de corriente.  

Ejemplo: Si se desconecta un conductor de corriente mientras circula corriente por 
el transformador, la corriente circulará a través del camino alternativo del 
conductor de potencial sin causar daño al instrumento ni una descarga 
eléctrica al operador. 

F 
ADVERTENCIA 

Es muy importante no conectar ningún conductor encima  de otro 
o demasiado cerca uno de otro. Tome las precauciones 
necesarias para asegurar que un conductor que se caiga no 
arrastre un segundo conductor en su caída.  
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Precauciones Generales de Seguridad 

Tanto el MTO como la Objeto Bajo  Prueba (UUT, por sus siglas en Inglés) 
deben considerarse fuentes de energía eléctrica en niveles que pueden causar la 
muerte instantánea. Observe las siguientes precauciones de seguridad:  

 Observe todas las advertencias de seguridad acerca del equipo. Ellas 
identifican zonas de riesgo inmediato que podrían provocar lesiones o la 
muerte. 

 Utilice este equipo sólo para los fines descritos en este Manual. Observe 
estrictamente las Advertencias y Precauciones que se indican en este Manual. 

 Trate todos los terminales de los sistemas de equipos con alimentación 
eléctrica de alta tensión como potenciales riesgos de sacudida eléctrica. 
Adopte todas las precauciones prácticas de seguridad para evitar el contacto 
con partes del equipo y circuitos asociados que estén con corriente. 

 Utilice barreras, vallas y/o advertencias adecuadas para mantener alejadas de 
las actividades de prueba a aquellas personas que no participan directamente 
en el trabajo. 

 Nunca conecte el equipo de prueba a equipos con corriente. 

 No utilice el aparato en atmósferas explosivas. 

 Siga los procedimientos de puesta a tierra y conexión que se recomiendan en 
este Manual. Desconecte siempre los conductores de prueba de la 
alimentación eléctrica antes de intentar desconectarlos del equipo de prueba. 
La conexión a tierra DEBE ser la primera que se hace y la última que se 
quita. Toda interrupción de la conexión a tierra puede generar un riesgo de 
choque eléctrico. 

 El personal en alturas mayores a 5 pies (1,52 m) de altura deberá cumplir con 
los requisitos de seguridad de sujeción adecuada. 

 El personal deberá utilizar equipo de seguridad adecuado para evitar lesiones 
corporales. 

 El personal que tenga marcapasos cardíaco deberá consultar con un 
especialista acerca de los posibles riesgos antes de utilizar este equipo o si va 
a estar cerca del equipo durante su funcionamiento. 

 La selección de los fusibles dependerá de la tensión de entrada. Para 230 
VCA se emplean fusibles de 3,15 amp y para 120 VCA se emplean fusibles 
de 6,3 amp.  
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Precauciones con respecto a la Alimentación  

Este instrumento funciona con una fuente de alimentación sinusoidal 
monofásica. Cuenta con un cable de alimentación trifilar y requiere una fuente de 
entrada del tipo bipolar de tres terminales (fase, neutro y tierra). La tensión a 
tierra desde la fase de la fuente de alimentación debe estar dentro de los 
siguientes valores de tensión de funcionamiento nominal:  

Para el N° de Cat. MTO210:  120/230 V  10%, sinusoidal monofásica, 50/60 
 2 Hz 

El polo neutro debe estar al potencial de tierra. Antes de efectuar la conexión a la 
fuente de alimentación, verifique que la capacidad nominal del instrumento 
corresponde a la tensión de la fuente de alimentación. El enchufe del cable de 
alimentación debe insertarse sólo en un receptáculo complementario con 
contacto a tierra.  

F 
ADVERTENCIA 

No deje de lado la conexión a tierra. Toda interrupción de la 
conexión a tierra puede generar un riesgo de choque eléctrico. 
Verifique que el receptáculo esté correctamente conectado antes 
de insertar el enchufe.  
 

Los circuitos de control del instrumento están protegidos por dos fusibles del 
circuito de la red eléctrica. Estos fusibles están ubicados en el módulo del 
interruptor de alimentación (ON / OFF) y pueden ser reemplazados por el 
operador. Para evitar el riesgo de descarga eléctrica y de incendio, utilice sólo el 
tipo de fusible que se especifica en la Sección 8, Lista de Piezas y Accesorios 
Opcionales, que sea idéntico con respecto al tipo, la tensión nominal y la corriente 
nominal. En la Sección 7 - Mantenimiento y Reparación, se define un 
procedimiento detallado para el Reemplazo de Fusibles.  

F ADVERTENCIA 
Antes de reemplazar los fusibles, desconecte el 
cable de la alimentación eléctrica. 
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3  
Preparación para una Prueba 

Preparación del Lugar 

Elija un lugar que cumpla con las siguientes condiciones: 

 El lugar debe ser lo más seco posible. 

 No debe haber material inflamable almacenado en las cercanías. 

 La zona de prueba debe contar con ventilación adecuada. 

 Verifique que todos los equipos estén desactivados y que pueda accederse a 
todos los terminales del Objeto Bajo Prueba (UUT). Coloque barreras de 
seguridad apropiadas para proteger al operador de los riesgos del tránsito y 
para evitar el acceso de personal no autorizado. Se recomienda el uso de 
luces de advertencia que serán provistas por el usuario. 

 Verifique que la conexión a tierra de la estación de trabajo local esté intacta y 
tenga continuidad de impedancia a tierra. 

Conexiones de Circuitos 

Las conexiones deben realizarse en el orden que se indica a continuación. 

1. Tierra. Utilice el Cable de Puesta a Tierra de Seguridad provisto por 
Megger (4,6 m) para conectar el Terminal de Tierra con Tuerca Mariposa 
del MTO directamente a la Tierra Física de la Estación de Trabajo Local. 
Verifique que el chasis del Transformador también tenga una conexión 
de baja impedancia al potencial de la Tierra Física de la Estación de 
Trabajo Local. 

2. Tierra de la Fuente de Alimentación. El Terminal de Tierra de la 
Fuente de Alimentación del equipo debe tener una conexión de menos 
de 100 miliohms de impedancia a la Tierra Física de la Estación de 
Trabajo Local. 

3. Conexión del Cable de Alimentación. Antes de realizar esta conexión, 
verifique que la Fuente de Alimentación cumple con los requisitos que se 
enumeran en la Sección 2, Seguridad, y la Sección 9, Especificaciones. 
Verifique además que el interruptor de conexión-desconexión 
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(ON/OFF) (Figura 1) esté en la posición desconectado (OFF). Conecte 
el cable de alimentación primero al MTO y luego a la fuente de 
alimentación. En este momento, deje el interruptor ON/OFF en la 
posición desconectado (OFF). 

4. Conexión del Cable en Serie (opcional). Si el usuario elige utilizar una 
impresora o PC externa, mediante software PowerDB Lite para PC, 
conecte entonces el cable en serie entre el MTO y la impresora o PC en 
este momento. 

5. Conexión del Cable de Control a Distancia (opcional). Si el usuario 

opta por accionar el Botón de Prueba  del MTO a distancia, conecte el 
cable de control remoto (RCC por sus siglas en Inglés) en este momento. 

6. Conexión de la Baliza de Advertencia (opcional). Si el usuario opta 
por accionar la Baliza de Advertencia, conecte en este momento el cable 
WBC cable y coloque la baliza en un lugar visible. 

7. Conexión del Interruptor de Bloqueo. El MTO cuenta con un 
interruptor de bloqueo externo. Conecte el interruptor de bloqueo 
externo mediante una conexión con enchufe tipo banana a los conectores 
(jacks) de entrada de bloqueo ubicados en el panel frontal. La función del 
interruptor de bloqueo es de apertura en caso de falla, por consiguiente si 
no se la utiliza deberá colocarse en los conectores un puente de conexión 
de bloqueo. Si el circuito se abre, en la pantalla LCD intermedia 
aparecerá “IntLoc”. 

8. Conexión de los Conductores I y V (sólo al extremo del MTO en 
este momento). Con las pinzas de sujeción desconectadas de la UUT, 
conecte los cables I y V al MTO en este momento. Verifique que todos 
los enchufes macho estén fijados firmemente al MTO de modo que no se 
aflojen, ni siquiera si el operador tropieza accidentalmente con los 
conductores de corriente.   

El MTO210 está programado para la lectura de dos entradas de tensión 
en todo momento. Si una entrada de tensión no se utiliza, las 
características de alta impedancia de entrada hacen que la unidad presente 
lecturas que no sean cero. Si se instala un puente conector, la lectura será 
muy baja. 

9. Conexión al Transformador. Cuando se prueban transformadores de 
alta tensión, debe tenerse cuidado en todo momento y deben observarse 
todas las precauciones de seguridad. Lea, comprenda y aplique todas las 
precauciones de seguridad y las conexiones de circuitos que se describen 
en la Sección 2, Seguridad, y en la Sección 3, Preparación para la Prueba. 
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F 
ADVERTENCIA 

Verifique que el transformador que va a ser probado 
esté completamente desactivado. Verifique cada uno 
de los arrollamientos. Verifique que todos los bornes 
del transformador estén desconectados de la línea o 
carga en el transformador. Las conexiones a tierra 
deben dejarse en su lugar. 
 

 

F 
ADVERTENCIA 

Para todas las pruebas aquí descritas, debe tenerse 
cuidado de verificar que todas y cada una de las 
pinzas de sujeción no utilizadas estén aisladas una de 
otra, de la tierra y del personal. 
 

En este momento, efectúe las conexiones al Transformador en Prueba (TUT por 
sus siglas en Inglés), según se describe en la parte que corresponde de la Sección 
5, Conexión al Transformador en Prueba. 
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4  
Funcionamiento del MTO210 

Cuando se prueban transformadores de alta tensión, debe tenerse cuidado en 
todo momento y deben observarse todas las precauciones de seguridad. Lea, 
comprenda y aplique todas las precauciones de seguridad y las conexiones de 
circuitos que se describen en la Sección 2, Seguridad, y en la Sección 3, Preparación 
para la Prueba 

F 
ADVERTENCIA 

Verifique que el transformador que va a ser probado 
esté completamente desactivado. Verifique cada uno 
de los arrollamientos. Verifique que todos los bornes 
del transformador estén desconectados de la línea o 
carga en el transformador. Las conexiones a tierra 
deben dejarse en su lugar. 
 

 

F 
ADVERTENCIA 

Para todas las pruebas aquí descritas, debe tenerse 
cuidado de verificar que todas y cada una de las 
presillas de sujeción no utilizadas estén aisladas una 
de otra, de la tierra y del personal. 
 

 

F 
PROCEDIMIENTO DE PARADA DE EMERGENCIA 

 
Pulse el botón rojo INTERRUPCIÓN DE EMERGENCIA 

DE LA PRUEBA o desconecte la alimentación. 

Descripción de la Secuencia de Prueba 

Una vez que se hayan tomado todas las precauciones y pasos de las Secciones 2, 
Seguridad, y 3 Preparación para la Prueba, y se hayan realizado las conexiones al 
Transformador en Prueba (TUT), el interruptor de alimentación podrá ser llevado a 
la posición encendido (ON). 

 

 

0, posición desconectado - OFF  

- , posición conectado - ON 



M 
 

 
AVTMMTO210-ES Rev 6 Mayo 2011 

20 

El MTO se acciona mediante el teclado numérico ubicado en el panel frontal. Al 
encenderse, se produce un sonido de corta duración (beep), el equipo de prueba 
realiza una autoverificación y se inicializan todas las variables de hardware y software.  

FUNCIÓN DE INICIALIZACIÓN 

El MTO realiza diagnósticos de puesta en marcha para asegurar que las piezas 
internas estén en condiciones de funcionamiento, antes de probar transformadores.  

Si aparece un código de error que no puede corregirse, el instrumento debe 
devolverse a Megger o a un centro de servicio autorizado para su reparación. Para 
ver las instrucciones en cuanto a la reparación, remitirse a la Sección 7, 
Mantenimiento y Reparación. Si no se detectan errores, en la pantalla aparecerán 
guiones (-) para resistencia y corriente.  

FUNCIÓN DE PRUEBA 

Una vez finalizada con éxito una función de inicialización, el usuario tiene la 
posibilidad de acceder a cualquiera de las cuatro funciones. En esta Sección se 
describe en detalle la FUNCIÓN DE PRUEBA. 

1. Coloque el Interruptor de Modo de Salida de Datos en el modo que se 
desee.  

 
2. Coloque el Interruptor de Modo de Función en el modo de PRUEBA.  

 
3. Fije la Gama de Corrientes necesaria para la Prueba.  

 
4. La ventana donde se muestra la corriente (I) destellará antes de iniciarse una 

secuencia de prueba, indicando que el aparato está listo.  

5. La ventana de indicación visual OHM 1 mostrará el valor de temperatura 
que la unidad guardará con los datos resultantes de todas las pruebas 

subsiguientes. Pulse  y  para cambiar la temperatura de los 
arrollamientos del transformador en el momento de la prueba. 

6. La ventana de indicación visual OHM 2 mostrará la sensibilidad del tiempo 
de Transición de Corriente y si la indicación visual de OHM 2 está activa 
(ON) o inactiva (OFF) durante la prueba. 
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Pulse   para cambiar la sensibilidad de transición. 0 es desactivado (off) y 
cuanto mayor es el número más sensible será el circuito para las transiciones 
de corriente. 

Pulse   para activar (ON) o desactivar (OFF) la pantalla del OHM 2 
durante la prueba. 

7. Valor de temperatura almacenado localmente que la unidad guardará con los 

datos resultantes de todas las pruebas subsiguientes. Pulse  y  
para cambiar la temperatura de los arrollamientos del transformador en el 
momento de la prueba. 

8. Al pulsar  la unidad aplicará corriente al transformador e intentará 
cargar el transformador hasta el máximo nivel de corriente fijado. Una vez 
que la corriente se ha estabilizado, la unidad calibrará todos los valores de 
entrada y tomará lecturas de resistencia continuamente. 

9. Al pulsar  durante la prueba, la unidad guardará y/o imprimirá los 
datos exhibidos (en función de la posición del Interruptor de Modo de 
Salida de Datos). Este botón permite tomar múltiples lecturas, tal como una 
prueba de un cambiador de tomas bajo carga. La unidad mostrará el número 
de prueba en la pantalla actual y en la pantalla “SAVED” en OHM 2 durante 
2 segundos para confirmar los datos guardados.    

10. Al pulsar  la unidad apagará la alimentación eléctrica al transformador, 
guardará y/o imprimirá los datos (en función de la posición del Interruptor 
de Modo de Salida de Datos) y mostrará los datos en la pantalla LCD para 
su revisión.   

Los datos permanecerán en la pantalla LCD hasta que se seleccione otra función 

o . 

FUNCIÓN DE DESCARGA 

 

Al pulsar este botón se detendrá la prueba y se descargará el 
transformador. El Indicador de Descarga ubicado a la izquierda se 
iluminará durante el ciclo de descarga. No se almacenan datos en la 
memoria ni se envían a la impresora.   

La descarga de un transformador luego de la prueba es crítica para evitar la excesiva 
acumulación de tensión en los terminales del transformador al quitarse la corriente. 
Cuando se desconecta la fuente de corriente, la energía continuará circulando en el 
transformador. Si hay alta impedancia (aire), la tensión a través del inductor 
aumentará hasta que se encuentre un camino de corriente para la energía. Esto puede 
ser un camino de corriente interno o externo. Es posible conectar un cable de 
cortocircuito a través de los aisladores del transformador antes de que se apague la 
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fuente de corriente. Dado que el cortocircuito posee muy poca resistencia, la 
corriente que circula por el transformador y el cortocircuito pueden continuar por un 
período de tiempo prolongado. Los circuitos de descarga del MTO están 
incorporados. Se iniciará automáticamente cuando se desconecte la fuente de 
corriente del transformador. También brindará una indicación visual de la descarga.    

FUNCIÓN DE DESMAGNETIZACIÓN 

 

Al pulsar este botón se realizará una desmagnetización del 
transformador. El Indicador de Desmagnetización ubicado a la derecha se 
iluminará durante el ciclo de desmagnetización. 

La desmagnetización de un transformador después de la prueba es crítica para una 
puesta en marcha suave del transformador. Si existe un gran flujo residual presente 
en el transformador en el arranque, las corrientes de irrupción del lado del primario 
del transformador pueden superar los valores de ajuste de los relés para el; disparo ; 
por consiguiente, es conveniente efectuar la desmagnetización luego de que se haya 
ejecutado una secuencia de prueba de resistencia de arrollamiento y de que el 
transformador haya sido programado nuevamente para su entrada en servicio.   

El MTO desmagnetiza el transformador mediante la magnetización automática del 
núcleo del transformador en la dirección positiva y negativa, con múltiples ciclos de 
corriente reducida. Durante las desmagnetizaciones, la unidad mostrará qué ciclo está 
procesando la unidad.  

La desmagnetización sólo debe realizarse una vez luego de que haya finalizado la 
prueba. Para una desmagnetización más eficaz, Los conductores de CORRIENTE y 
TENSIÓN deben conectarse a los arrollamientos del lado de alta tensión. 

El ciclo de desmagnetización llevará un cierto tiempo para su ejecución. Es 
equivalente a tomar múltiples pruebas en secuencia.  

FUNCIÓN DE PRUEBA A DISTANCIA 

El principal objetivo de esta función es tomar datos secuenciales para almacenar 
durante una sola prueba. Es de utilidad para la prueba de cambiadores de toma, 
cuando deben leerse en secuencia múltiples valores de resistencia sobre una misma 
fase y diferentes posiciones del cambiador (sin movimiento de conductores de 
prueba).  

1. Con el MTO apagado conecte el Cable de Control a Distancia (RCC) al 
conector remoto ubicado en el panel frontal  del instrumento. 
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2. Encienda (-) el instrumento. 

La Unidad detectará el Interruptor a Distancia e indicará “mnt 0/1”. El 0 indica 
que el interruptor no ha sido pulsado; el 1 indica cuando el interruptor ha sido 
pulsado. Esto indica que se está en el Modo a Distancia y que el botón está 
funcionando correctamente. 

3. Para iniciar una secuencia de prueba, pulse el botón  ubicado en el 
panel frontal. Esto NO  hará que comience la prueba, sino que sólo hará que 
se ilumine el indicador de AT. El Indicador a Distancia  permanecerá 
desactivado.  

4. El operador irá al cambiador de tomas, verificará que esté en la posición de 
arranque correcta, y luego, para iniciar la primera prueba, pulsará el botón 

del RCC . 

El Indicador a Distancia destellará lentamente para indicar carga. Cuando el 
Indicador a Distancia se queda fijo, la lectura es estable.   

5. Al pulsar el botón del RCC  se guardará el resultado estable en la 
memoria. El MTO está siempre verificando si se interrumpe la corriente en 
un cambio de toma. 

Si se produce una situación de Corte Antes del Cierre, el Indicador de Corte Antes 
del Cierre destellará rápidamente. 

 
Según la duración del corte, sucederá una de dos cosas. 

1. En caso de cortes breves, la unidad destellará rápidamente, pero el sistema 

seguirá funcionando y dará lecturas de resistencia. Pulse  para acusar 

recibo del evento o guardarlo, o pulse  para eliminar el evento. 

2. En caso de cortes de más de 200 mseg, el sistema se apagará 
automáticamente. El Indicador de AT se apagará y el Indicador de Descarga 
y el Indicador a Distancia destellarán. 

Para apagar el Indicador de Corte Antes del Cierre, pulse . 
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Si no existe tal situación, el Indicador a Distancia comenzará a destellar 
lentamente otra vez hasta que el circuito se estabilice a partir del cambio de 
toma, y luego quedará fijo hasta que esta configuración se haya estabilizado. 

3. Pulse el botón del RCC  para registrar la lectura otra vez y el proceso 
continuará hasta que se hayan probado todas las tomas del transformador. 

FUNCIONES DE ALMACENAMIENTO DE DATOS 

El MTO puede guardar hasta 2000 resultados de pruebas en la memoria, con fines 
de archivo. Si los datos se guardan mientras se efectúa la prueba, la unidad puede 
recorrer la memoria después de la prueba, en un proceso de revisión.  

 

1. Coloque el Interruptor de Modo de Salida de Datos en el Modo de Revisión de 
Almacenamiento. La unidad presentará los últimos datos almacenados en modo 
alternativo. En la pantalla superior destellarán el número de prueba registrado y 

la hora de la prueba. Al pulsar , la unidad mostrará resultados detallados de 

corriente y dos valores de resistencia. Al pulsar  se alternará entre las dos 
pantallas. 

NOTA:  Si la memoria del MTO está llena, aparecerá en pantalla el mensaje 
“Memoria LLENA” al encender o la primera vez que se revisen los datos.  

 

2. Pulse  y  para recorrer los datos almacenados. 

3. Pulse   para imprimir los datos exhibidos. 

TEST
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4. Pulse   para eliminar de la unidad los últimos datos almacenados. La 
unidad pedirá confirmación preguntando si está SURE (SEGURO) en la pantalla 

OHM1. Pulse  para confirmar la eliminación. 

5. Pulse   por segunda vez para eliminar de la unidad todos los datos 
almacenados. La unidad pedirá confirmación preguntando si está SURE 

(SEGURO) en la pantalla OHM1. Pulse  para confirmar la eliminación. 

6. Pulse   por tercera vez para salir del modo de eliminación. 

FUNCIÓN DE CONFIGURACIÓN DE LA HORA 

El MTO puede fijar la Hora del Día desde la interfaz del panel delantero. 
Coloque el interruptor de modo de función en Configuración de Hora y Fecha, 
según se indica a continuación. 

 

1. Coloque el Interruptor de Modo de Función en el modo de configuración de 
hora. 

 

2. Con  y  recorra el año, mes, día, hora, minuto y segundo. El parámetro 
activo parpadeará entre activado y desactivado. 

3. Con  y  aumente o disminuya el parámetro seleccionado.  

4. Con  confirme los cambios efectuados en los parámetros seleccionados. 

TEST
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FORMATO DE CONFIGURACIÓN DE HORA Y FECHA  

El MTO puede cambiar el Formato de la Fecha.  

 

1. Coloque el Interruptor de Modo de Función en el Modo de Formato de 
Fecha. 

 

2. Utilice  y  para desplazarse desde año/mes/día a mes/día/año a 
día/mes/año. 

3. Con  confirme los cambios efectuados en los parámetros seleccionados.  

TEST
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MODO DE ACTUALIZACIÓN DE FIRMWARE 

El MTO tiene dos procesadores, comúnmente denominados procesador inferior 
y superior. Cada procesador requiere software para funcionar correctamente. En 
esta sección se describe el método para cambiar el firmware en un MTO 

OBTENCIÓN DEL SOFTWARE MÁS RECIENTE: 

La mejor manera de conseguir el software más reciente es visitar el sitio 
Megger.com. 

Una vez que ha accedido al sitio, 

1. Seleccione el país en el que se encuentra. 

2. Quizás tenga que registrarse para conectarse al sitio. 

3. Seleccione Descargas de Software. 

4. Seleccione MTO. Debería haber una lista de software disponible para 
descargar. 

5. Seleccione la última versión de firmware que haya. El software está 
integrado en forma de archivo ZIP.  

6. Descargue el archivo y ejecute. El software se extraerá y ejecutará 
automáticamente.  

7. En la pantalla de la PC aparecerá un mensaje de Bienvenida de Megger. 
Antes de continuar, conecte la PC al MTO210 por medio de un cable 
Ethernet.  

8. Siga las instrucciones que aparecen en pantalla y el software lo guiará a 
través del proceso de selección de la Interfaz Ethernet, verificando que el 
MTO esté conectado, encendiendo y apagando el MTO para sincronizar 
el cargador de arranque con la PC, seleccionando el archivo para 
descargar y descargando finalmente el software.    
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5  
Prueba de Transformadores 

F 
ADVERTENCIA 

Al probar un transformador o regulador, verifique que el ejemplar 
que va a probarse cuenta con una buena conexión a tierra, según se 
muestra en todos los diagramas de conexión. 

Prueba de Resistencia de Arrollamientos 
Las mediciones de resistencia de arrollamientos en transformadores son de 
fundamental importancia para los siguientes fines: 

 Cálculo del componente I2R de las pérdidas en conductores. 

 Cálculo de temperatura del arrollamiento al final de un ciclo de prueba de 
temperatura. 

 Como instrumento de diagnóstico para la evaluación de posibles daños in 
situ. 

Los transformadores están sometidos a vibración. Se producen problemas o fallas 
debido a defectos de diseño, montaje, manipulación, ambientes desfavorables, 
sobrecarga o mantenimiento defectuoso. La medición de la resistencia de los 
arrollamientos permite constatar que las conexiones sean correctas, y las mediciones 
de resistencia indican que no existen graves desajustes o desconexiones. Muchos 
transformadores cuentan con tomas incorporados. Estas tomas permiten que la 
relación de transformación aumente o disminuya en fracciones de porcentaje. 
Algunos cambios en la relación implican un movimiento mecánico de un contacto 
de una posición a otra. Estos cambios de tomas deberán también verificarse durante 
una prueba de resistencia de arrollamiento. 

Independientemente de la configuración, ya sea estrella o delta, las mediciones se 
efectúan normalmente fase a fase y se realizan comparaciones para determinar si las 
lecturas son comparables. Si todas las lecturas presentan una diferencia entre sí 
dentro del uno por ciento, entonces son aceptables. Debe tenerse en cuenta que la 
prueba tiene por objeto verificar la existencia de grandes diferencias entre los 
arrollamientos y rupturas en las conexiones. Las pruebas no se llevan a cabo para 
duplicar las lecturas del dispositivo fabricado, que ya ha sido ensayado en fábrica en 
condiciones controladas, y quizás a otras temperaturas. 

Las resistencias de los arrollamientos de los transformadores se miden para 
comprobar la presencia de anormalidades debidas a conexiones flojas, hilos rotos y 
resistencia de alto contacto en cambiadores de tomas. La interpretación de los 



M 
 

 
AVTMMTO210-ES Rev 6 Mayo 2011 

30 

resultados se basa por lo general en una comparación de mediciones efectuadas por 
separado en cada fase en el caso de un arrollamiento conectado en estrella, o entre 
pares de terminales en un arrollamiento conectado en delta. La comparación 
también puede realizarse con datos originales medidos en fábrica.  

Prueba de un Transformador Monofásico 
PRUEBA DE UN SOLO ARROLLAMIENTO 

 
Figura 2: Medición de un Solo Arrollamiento 

F ADVERTENCIA 

¡No desconecte los conductores hasta que todos  
los indicadores marquen OFF! 

PROCEDIMIENTO: 

1. Conecte el cable de alimentación a la unidad y enchufe en el tomacorriente 
de 120 V /230 V. 

2. Conecte el cable de tierra de seguridad desde el Panel Superior a la tierra del 
Transformador. 

3. Fije las condiciones siguientes: 

a. 

 

Coloque en la posición  de PRUEBA. 

b.  

 

Coloque en la CORRIENTE 
MÁXIMA DE PRUEBA que se desee. 
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c.  

 

Coloque en la SALIDA DE DATOS 
que se desee. 

4. Conecte los conductores de tensión "V1" al arrollamiento del ejemplar que 
va a probarse. No sujete los conductores de tensión sobre los conductores 
de corriente, porque esto agregará resistencia de contacto a la medición. Ver 
Figura 2. 

Conecte la salida de corriente (I) al arrollamiento del espécimen que se prueba. 
Ver Figura 2. 

5. Coloque el interruptor de alimentación en la posición "ON" (-).  

6. Pulse el botón  para iniciar la circulación de corriente. 

7. La pantalla más pequeña ubicada en la parte superior indica la salida de 
corriente, y la pantalla Ohm1 indica la resistencia del ejemplar que se prueba. 
 

NOTA En el caso de transformadores más grandes, deberá observarse el valor de 
resistencia que aparece en pantalla y deberán tomarse las lecturas de 
resistencia una vez que la lectura se estabilice. La variación en la lectura de 
resistencia indicada se debe a la inductancia del transformador. En 
transformadores pequeños, la desviación dura sólo algunos segundos; en 
transformadores de alta tensión monofásicos (500 kV), la desviación podría 
durar una fracción de minuto; en transformadores grandes conectados en 
delta, el tiempo de estabilización podría ser mucho mayor. Ver la Sección 
“Prueba de Arrollamientos Conectados en Delta”. Un transformador 
monofásico de 500 kV y 345 MVA necesita aproximadamente 2 minutos 
para que la pantalla se estabilice. 

8. Una vez completada, pulse  para finalizar la medición y descargar la 
corriente. La descarga habrá finalizado cuando el indicador de descarga esté 
en “off”. 

9. Retire del transformador los conductores de corriente. 

10. Retire del transformador los conductores de tensión. 
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PRUEBA DE DOS ARROLLAMIENTOS 

Este procedimiento describe la prueba de ambos arrollamientos (de alta y baja) 
en un transformador monofásico, al mismo tiempo. 

 

Figura 3: Prueba de Dos Arrollamientos 

F ADVERTENCIA 
¡No desconecte los conductores hasta que  
todos los indicadores marquen OFF! 

NOTAS: Debe tenerse particular cuidado de que el puente conector de la Figura 3 
esté conectado a polaridades opuestas del transformador, de modo de 
reducir el tiempo de saturación del núcleo del transformador. 

 Si la resistencia entre los 2 arrollamientos es mayor que un múltiplo de 
10, podrá obtenerse una lectura más exacta probando los arrollamientos 
por separado. 

PROCEDIMIENTO: 

1. Conecte el cable de alimentación a la unidad y enchufe en el 
tomacorriente de línea. 

2. Conecte el cable de tierra de seguridad desde el Panel Superior a la tierra 
del Transformador. 
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3. Fije las condiciones siguientes: 

a 

 

Coloque en la posición  de PRUEBA. 

b.  

 

Coloque en la CORRIENTE MÁXIMA DE 
PRUEBA que se desee. 

c.  

 

Coloque en la SALIDA DE DATOS que se desee. 

4. Conecte los conductores de tensión "V1" a los terminales H1 y H2 del 
transformador en prueba.  Ver Figura 3. 

5. Conecte los conductores de tensión "V2’ a los terminales X1 y X2 del 
transformador en prueba.  Ver Figura 3. 

Conecte los conductores de corriente (I) al arrollamiento que se prueba. Ver 
Figura 3. Agregue el Cable de Puente de H2 a X1. Esto permitirá que la 
corriente circule desde el arrollamiento primario hacia el arrollamiento 
secundario. Los conductores de tensión deberán colocarse siempre entre 
los conductores de corriente y el transformador. Ver Figura 3. 

NOTA: Siempre trate de mantener la misma polaridad del transformador, para un 
mejor tiempo de carga del transformador. Si el conductor positivo de la 
corriente se conecta al borne positivo del arrollamiento primario, mantenga 
esta polaridad conduciendo la corriente desde el arrollamiento primario H2 
que forma un puente con el borne positivo del arrollamiento secundario X1.  

6. Coloque el interruptor de alimentación en la posición "ON" (-). Pulse el 

botón  para iniciar la circulación de corriente. 

7. La pantalla más pequeña ubicada en la parte superior indica la salida de 
corriente, la pantalla Ohm1 indica la resistencia del arrollamiento primario, y 
la pantalla Ohm2 indica la resistencia del arrollamiento secundario del 
ejemplar en prueba. 

8. Una vez completada la medición, pulse  para finalizar y descargar la 
corriente. La descarga habrá finalizado cuando el indicador de descarga esté 
en “OFF” (0). 
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Corrección por Temperatura 

En el informe de prueba del transformador podría ser necesario convertir las 
mediciones de resistencia a valores que correspondan a la temperatura de 
referencia.  

Es importante estimar la temperatura del arrollamiento en la medición. Si el 
transformador tiene indicador de la temperatura del arrollamiento, se utilizarán 
estas lecturas. Si no, se supone que la temperatura del arrollamiento es la misma 
que la temperatura del aceite en las siguientes condiciones: 

 Si el transformador ha estado fuera de servicio durante al menos 3 horas 

 Si la temperatura del líquido aislante se ha estabilizado, y la diferencia entre la 
temperatura superior e inferior no supera los 5ºC. 

Si el transformador se mide sin aceite, se supone por lo general que la 
temperatura del arrollamiento es la misma que la del aire circundante.  

Conversión de Mediciones de Resistencia 

Por lo general, las mediciones de resistencia de arrollamientos se convierten a 
una temperatura de referencia estándar. 

Las conversiones se realizan mediante la siguiente fórmula: 

Rs = Rm ( Ts + Tk )/( Tm + Tk ) 

donde: 

Rs = resistencia a la temperatura deseada Ts 

Rm = resistencia medida 

Ts = temperatura de referencia que se desea 

Tm = temperatura a la cual se midió la resistencia 

Tk = 234.5 (cobre) 

Tk = 225 (aluminio) 
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Prueba de un Transformador Trifásico 

Se detallan a continuación los diferentes métodos a utilizarse en la prueba de 
transformadores trifásicos. Las mediciones se realizarán en uno o dos 
arrollamientos a la vez. Se utilizarán los diagramas de conexión (Figuras 4 a 7) 
conjuntamente con el procedimiento de “Prueba de Transformadores 
Monofásicos”. El único cambio será la ubicación de los conductores. 

NOTA:  Cuando se prueban simultáneamente los arrollamientos Primario y 
Secundario, debe tratarse de mantener la misma polarización del 
transformador, para un mejor tiempo de carga del transformador. Ver 
Cuadro 1. 

PROCEDIMIENTO: 

1. Arrollamiento Trifásico configurado en Estrella, con Neutro  

 

Figura 4: La lectura obtenida es por fase, Resistencia de Arrollamientos A-N 

Utilice el diagrama anterior junto con el procedimiento "Prueba de 
Transformadores Monofásicos". 
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2. Arrollamiento Trifásico configurado en Estrella, sin el Neutro 

 

Figure 5: La lectura obtenida está entre pares de terminales, Resistencia de Arrollamientos A y B 

Utilice el diagrama anterior junto con el procedimiento "Prueba de 
Transformadores Monofásicos". 

 

3. Arrollamiento trifásico configurado en Delta  

 

Figura 6: La lectura está entre pares de terminales. La resistencia de A en paralelo con los 
Arrollamientos B+C 

Utilice el diagrama de la Figura 6 junto con el procedimiento "Prueba de 
Transformadores Monofásicos". 
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Prueba de Arrollamientos Configurados en Delta 

Probar la resistencia de arrollamientos en delta puede ser un procedimiento que 
lleve mucho tiempo. En ciertos arrollamientos de BT conectados en delta, el 
tiempo de equilibrio adecuado puede llegar hasta 30 - 60 minutos en un 
transformador grande, lo cual supera ampliamente las restricciones de tiempo en 
muchas pruebas. 

El método para probar rápidamente arrollamientos con configuración en delta 
exige que tanto el lado de alta como el de baja estén conectados en serie con la 
fuente de corriente del MTO (Ver Cuadro de Conexiones 1). Al utilizar los dos 
arrollamientos, de AT y BT, para magnetizar el núcleo, la corriente de 
magnetización efectiva de la prueba aumenta con la relación de espiras. Como 
ejemplo, probar el lado de Baja Tensión de un transformador con conexión 
estrella-triángulo (Yd) de 100 / 10 kV con doble inyección lateral a 10A es lo 
mismo que probar sólo el lado de Baja Tensión de ese mismo transformador a 
68A. Aún cuando sólo debe verificarse un lado del transformador, conectar en 
serie los arrollamientos de alta y baja acelerará la prueba 10 veces o más.  

RESISTENCIA DE ARROLLAMIENTOS EN DELTA 

Los datos del fabricante acerca de la resistencia de los arrollamientos por lo 
general se presentan para cada arrollamiento, en el caso de configuraciones en 
Estrella, y por pares de terminales, en el caso de arrollamientos en Delta. Si se da 
el caso raro de que los datos del fabricante se presenten por arrollamiento 
también para una conexión en delta, se recomienda calcular nuevamente los 
valores por pares de terminales y comparar con los resultados de las mediciones 
in situ.   

Ravg = Resistencia promedio de un arrollamiento 

Rtp = Resistencia del arrollamiento entre pares de terminales 

Rtp = Ravg x 0,6667 
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CUADRO 1. 

EJEMPLOS DE CONFIGURACIONES DE CONEXIONES DE 

TRANSFORMADORES PARA INYECTAR CORRIENTE DE PRUEBA Y 

MEDIR DOS ARROLLAMIENTOS SIMULTÁNEAMENTE 

Grupo Vectorial 

Configuración de mediciones 

Conexiones de Corriente 
Med. 

canal 1 
Med. 

canal 2 

+ Corriente Puente conector - Corriente  +  -  +  - 

Dd0 
H1 H3-X1 X3 H1 H3 X1 X3 

H2 H1-X2 X1 H2 H1 X2 X1 

H3 H2-X3 X2 H3 H2 X3 X2 

Dyn7 
H1 H3-X0 X1 H1 H3 X0 X1 

H2 H1-X0 X2 H2 H1 X0 X2 

H3 H2-X0 X3 H3 H2 X0 X3 

Dyn1 
H1 H3-X1 X0 H1 H3 X1 X0 

H2 H1-X2 X0 H2 H1 X2 X0 

H3 H2-X3 X0 H3 H2 X3 X0 

YNyn0 
H1 H0-X1 X0 H1 H0 X1 X0 

H2 H0-X2 X0 H2 H0 X2 X0 

H3 H0-X3 X0 H3 H0 X3 X0 

Ynd1 
H1 H0-X1 X2 H1 H0 X1 X2 

H2 H0-X2 X3 H2 H0 X2 X3 

H3 H0-X3 X1 H3 H0 X3 X1 

Dy1 
H1 H3-X1 X2 H1 H3 X3 X2 

H2 H1-X2 X3 H2 H1 X1 X3 

H3 H2-X3 X1 H3 H2 X2 X1 

YNd7 
H1 H0-X2 X1 H1 H0 X2 X1 

H2 H0-X3 X2 H2 H0 X3 X2 

H3 H0-X1 X3 H3 H0 X1 X3 

Dyn5 
H1 H2-X0 X1 H1 H2 X0 X1 

H2 H3-X0 X2 H2 H3 X0 X2 

H3 H1-X0 X3 H3 H1 X0 X3 

Dy11 
H1 H3-X1 X3 H1 H3 X1 X3 

H2 H1-X2 X1 H2 H1 X2 X1 

H3 H2-X3 X2 H3 H2 X3 X2 

Dyn11 
H1 H2-X1 X0 H1 H2 X1 X0 

H2 H3-X2 X0 H2 H3 X2 X0 

H3 H1-X3 X0 H3 H1 X3 X0 
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Prueba de Transformadores con Cambiadores de Tomas  

Muchos transformadores utilizados actualmente tienen tomas incorporadas en ellos. 
Estas tomas permiten incrementar o reducir la relación de transformación en un 
cierto porcentaje. Los cambios en la relación de transformación implican un 
movimiento mecánico de un contacto de una posición a otra. Es este contacto que 
debe verificarse a través de su resistencia de contacto e integridad mecánica.  

El contacto puede deteriorarse por una serie de razones. 

1. Si se ha desalineado al ser fabricado, causando un contacto superficial 
insuficiente. La corriente a plena carga sobrecalienta la superficie de contacto 
y hace que se queme. 

2. Si la corriente que pasa por el contacto supera el valor especificado para 
plena carga. 

3. Si las operaciones de cambio de tomas no cumplen con la secuencia 
requerida de “Cierre antes del Corte”, se producirá la formación de arcos en 
la superficie de contacto. 

4. Si un cambiador de tomas sin carga se cambia de posición mientras está en 
carga. La superficie de contacto queda picada y dispareja.    

Los cambiadores de tomas se dividen en dos tipos: “En carga” y “Sin carga”. El 
cambiador de tomas “En carga” permite la selección del cambio de relación de 
transformación, mientras el transformador está en funcionamiento. Esto significaría 
que la relación de transformación de un transformador puede cambiarse mientras 
hay energía (corriente) pasando por él. El ejemplo más común de este tipo de 
cambiador de tomas “En carga” es un Regulador de Tensión. 

El MTO es ideal para probar cambiadores de tomas “En carga” porque el 
instrumento puede dejarse encendido (ON) mientras se pasa de toma a toma. Esto 
permite que el operador efectúe mediciones muy rápidamente sin descargar y luego 
recargar el transformador para cada toma. El MTO se equilibrará nuevamente luego 
de cada cambio de toma. Si la toma es defectuosa (abierta) o si existe incluso una 
fracción de tiempo (1 ms) durante la cual el circuito está abierto, el MTO indicará la 
presencia de un circuito abierto. Si la interrupción de corriente supera los 10 ms, el 
MTO detendrá la prueba y descargará el transformador automáticamente. Esto da al 
operador una clara indicación de una posible falla en el cambiador de tomas. En esta 
situación de ABIERTO, la corriente CD del MTO no hará ningún daño al 
transformador.    

El segundo tipo de cambiador de tomas es el “Sin carga”. Este no es tan común 
como el tipo “En carga” porque para cambiar tomas el transformador debe ser 
sacado de servicio o al menos desconectado de la carga. El MTO podrá probar 
tomas “Sin carga”, pero el transformador deberá descargarse entre cambios de 
tomas. Si el transformador no se descarga entre cambios de tomas, el transformador 
o la unidad de prueba podrían sufrir daños.  
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Prueba de Reguladores de Tensión 

Este procedimiento describe las conexiones básicas a un regulador monofásico. 
La principal prueba para un regulador consiste en la evaluación del estado de las 
posiciones de las tomas. Ya que existe una gran cantidad de tomas (por lo general 
de 15 a 32), esta prueba normalmente llevaría mucho tiempo. Con el MTO, este 
tiempo de prueba se ve drásticamente reducido porque el instrumento 
permanecerá encendido mientras se cambian las posiciones de las tomas “En 
carga”. 

Todos los reguladores cuentan con reactores de derivación internos. Es en razón 
de la presencia de estos reactores que el tiempo de estabilización del MTO 
variará. En posiciones impares, el tiempo de equilibrio será mayor que en las 
posiciones pares. Esto se debe a la corriente circulante generada con las tomas en 
las posiciones impares, y se muestra a continuación:  

 

Figura 7: Toma en Posición Impar 

 

Figura 8: Toma en Posición Par 
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Figure 9:  Conexión a un Regulador  

F ADVERTENCIA 
 
¡No desconecte los conductores hasta que todos los indicadores 
marquen OFF! 

PROCEDIMIENTO 

1. Conecte el cable de alimentación a la unidad y enchufe en el 
tomacorriente de 120 /240 V. 

2. Fije las condiciones siguientes: 

a 

 

Coloque en la posición de PRUEBA. 

b.  

 

Coloque en la corriente máxima de 
prueba que se desee. 

c.  

 

Coloque en el MODO DE SALIDA 
DE DATOS. 

3. Conecte los conductores de tensión "V1" al arrollamiento en prueba. Ver 
Figura 9. 
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4. Conecte los conductores de corriente (I) al arrollamiento en prueba. No 
sujete los conductores de tensión sobre los conductores de corriente, 
porque esto agregará resistencia de contacto a la medición. Los 
conductores de tensión deben colocarse siempre entre el 
transformador y los conductores de corriente. Ver Figura 9. 

5. Coloque el interruptor de alimentación en la posición "ON" (-). 

6. Pulse el botón  para iniciar la circulación de corriente.  

7. La pantalla superior indica la salida de corriente y la pantalla Ohm1 indica 
la resistencia. 

8. Recorra las TOMAS del cambiador de tomas “En carga”. La resistencia 

debería cambiar ligeramente con cada cambio de TOMA. Pulse  
para guardar y/o imprimir las lecturas de cada toma. 

Si se produce una situación de Corte Antes del Cierre, el Indicador de Corte 
Antes del Cierre destellará rápidamente. 

 
Según la duración del corte, sucederá una de dos cosas. 

1. En el caso de cortes breves, la unidad destellará rápidamente pero el 
sistema continuará funcionando y dará lecturas de resistencia. 

2. En el caso de cortes de más de 10mseg, el sistema se apagará 
automáticamente. El Indicador de AT se apagará y el Indicador de 
Descarga destellará. 

Para apagar el Indicador de Corte Antes del Cierre luego de un episodio, 

pulse . 

Si no existe tal situación, el Indicador a Distancia comenzará a destellar 
lentamente de nuevo, hasta que el circuito se estabilice a partir del cambio de 
toma, y luego se queda fijo cuando esta configuración se ha estabilizado. 

3. Pulse  para registrar nuevamente la lectura, y el proceso continuará  
hasta que se hayan probado todas las tomas del transformador. 

4. Una vez completadas las mediciones, pulse  para finalizar y 
descargar la corriente. La descarga habrá finalizado cuando el indicador 
de descarga esté en “off”. 
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Desmagnetización de un Transformador 
El MTO desmagnetiza el transformador mediante la magnetización automática 
del núcleo del transformador en la dirección positiva y negativa, con múltiples 
ciclos de corriente reducida. La función de desmagnetización es equivalente a 
generar corrientes de prueba para múltiples pruebas de resistencia. Durante el 
ciclo de desmagnetización, la unidad mostrará la cantidad de ciclos cumplidos en 
el proceso. 

1. La desmagnetización sólo debe realizarse una vez luego de que hayan 
finalizado todas las pruebas. 

2. Para lograr una desmagnetización más eficaz, los conductores de 
CORRIENTE y TENSIÓN deben conectarse a una fase / par de bornes en 
los arrollamientos del lado de alta (primarios). 

3. Los conductores de tensión deben conectarse como en una prueba. La 
energía de descarga es absorbida a través de los conductores de tensión. 

4. En un transformador trifásico sólo debe desmagnetizarse a través un 
arrollamiento. 
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6 
Software PowerDB Lite para la Serie MTO210  

Introducción 

PowerDB Lite es una versión gratuita aunque de capacidad reducida del software 
PowerDB, que está diseñada especialmente para controlar y/o extraer 
información de los instrumentos Megger. La principal diferencia entre el 
PowerDB Lite y el PowerDB es que el PowerDB está diseñado para funcionar 
con equipos de todos los fabricantes y posee funciones de sincronización tanto 
in situ como en la oficina. El PowerDB Lite presentará los datos de prueba en un 
formulario profesional que puede enviarse a una impresora o una impresora 
Acrobat distiller para convertir a un formato de archivo pdf tal como el PDF995.  

El PowerDB Lite permite utilizar un subconjunto de los formularios estándar 
PowerDB que son apropiados para instrumentos Megger específicos. El 
PowerDB Lite detecta el instrumento y habilita el o los formularios apropiados. 
Los datos pueden ingresarse en pantalla o pueden ser directamente adquiridos 
mientras se utiliza el instrumento de prueba. Los formularios de datos 
completados pueden guardarse en la computadora en forma de archivos. 

Para mayor información o ver actualizaciones del software, visite el sitio 
www.PowerDB.com. 

Sistema Mínimo Recomendado 

 Sistema Operativo: Windows 2000 o posterior 

 RAM: 64 MB de RAM mínimo, se recomienda 512+ MB de RAM  

 Procesador: procesador Clase Pentium de 300 MHz como mínimo, se 
recomienda 1 GHZ o mejor  

Para obtener información acerca de las características de la versión completa del 
PowerDB, favor de visitar nuestro sitio Web www.powerdb.com. Familiarícese con 
las siguientes características programando una demostración en directo vía 
info@powerdb.com. 

 Sincronice todos sus registros de pruebas en una sola Base de Datos 
Empresarial 

 Reduzca el tiempo de prueba 

 Mejora la integridad de los datos 
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 Normaliza los procedimientos de prueba 

 Utilice fácilmente las tendencias Históricas para la evaluación de los 
resultados de las pruebas 

 Elimina la necesidad de instalar y mantener una aplicación de software por 
cada instrumento 

 Elimina todas las hojas de prueba escritas 

 Cree sus propios formularios de prueba 

 Utilice o modifique uno de nuestros 200 formularios de prueba incorporados 

 Procedimiento de un paso para generar informes de pruebas con índice y 
resúmenes complementarios 

 Permite que todos sus datos de pruebas in situ sean integrados con sistemas 
CMMS tal como Maximo o SAP. 

 Importa > de muchas otras aplicaciones de software estándar de la industria 

 Controla e importa datos de muchos instrumentos que no son de Megger  

Instalación del Software  

Para instalar el PowerDB Lite, inserte el CD del PowerDB Lite CD en su unidad 
de CD-ROM y siga las instrucciones que aparecen en pantalla.  

1. Acepte los términos (Yes) del acuerdo de Licencia.  
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2. Seleccione el lugar de destino de los archivos del  PowerDB Lite. 

 

 

3. Seleccione la Configuración Predeterminada.  
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4. El Asistente InstallShield finalizará la instalación del PowerDB Lite. Haga 
clic en Finish (Finalizar) para cerrar el programa de instalación. 
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Utilización del Software PowerDB Lite  

1. INICIO 

1. Seleccione su Instrumento MTO210 en la pantalla Configuración del 
Instrumento. 

a. Siempre puede verse la pantalla Configuración del Instrumento desde 
el menú herramientas o F3. 

 
b. El MTO utiliza comunicación en serie. Seleccione la configuración de 

comunicación apropiada en la pantalla Configuración de Dispositivo en 
Serie.  

c. Utilice el botón Actualizar para buscar puertos que podrían no estar 
conectados al ponerse en funcionamiento el PowerDB Lite. Si está 
utilizando un puerto en serie USB y no conoce el puerto asignado a 
él, favor de realizar las acciones siguientes: 

1. Retire el adaptador serie USB. 

2. Pulse Actualizar. 

3. Haga clic en la Lista Desplegable de Puertos y registre las 
opciones. 

4. Conecte nuevamente el adaptador. 

5. Pulse Actualizar. 

6. Seleccione el puerto que no estaba en la lista original. 
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Verifique que la velocidad de transmisión en baudios esté fijada en 9600, la 
Paridad esté fijada en ninguna, el Tamaño en Bytes esté fijado en 8, y Bits de 
Parada esté fijado en 1.  

 
d. Para finalizar haga clic en Aceptar (OK)  en la pantalla Configuración 

del Instrumento.  

2. SELECCIONE UN FORMULARIO 

Una vez definido el instrumento, el PowerDB presentará los formularios creados 
en la base de datos y asociados con ese instrumento. El formulario 
predeterminado de fábrica es el 56352. 
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3. CÓMO INGRESAR DATOS DE PRUEBA 

a. La información del encabezado y placa de características puede 
ingresarse manualmente en un formulario. 

b. Download Test Data (Descargar Datos de Prueba) – Pulsando 
este botón de la pantalla se descargarán automáticamente todos los 
datos del MTO. 

c. Eliminar Registros Seleccionados – Cuando el PowerDB está 
conectado al MTO, el usuario puede seleccionar pruebas de la lista de 
pruebas descargadas que se muestran, y eliminar pruebas específicas. 

d. Delete ALL Test Data (Eliminar TODOS los Datos de Prueba) 
– Cuando se pulsa este botón del software, se eliminarán del 
instrumento todos los datos. 

 

4. COMENTARIOS Y CARENCIAS 

Al ser importados en la versión completa del PowerDB, los comentarios y las 
deficiencias  de cada formulario se utilizan para generar informes resumen. Estos 
informes resumen repiten las anotaciones e indican el número de página si está 
indicado. Esto permite que el usuario recorrer una página en particular y ver una 
anomalía que ha sido informada. Para mayor información acerca de las 
características del PowerDB, visite nuestro sitio Web www.PowerDB.com.  
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5.  CÓMO GUARDAR DATOS 

a. Seleccione en el menú File>Save (Archivo>Guardar), o pulse CTRL+S, 
o pulse el botón Save (Guardar) de la barra de herramientas. 

b. La pantalla Guardar Como le permitirá especificar un lugar para 
guardar su archivo PowerDB Lite y el nombre del archivo.  
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 6. CÓMO ABRIR UN ARCHIVO EXISTENTE 

a. Seleccione File> Open (Archivo > Abrir) del menú. 

 
b. Busque hasta encontrar el archivo que desea abrir. 

c. Pulse el botón Open dialog (Abrir Cuadro de Diálogo). 

d. Si el archivo contiene múltiples fechas de pruebas, seleccione la Fecha 
que desea abrir para editar, o seleccione Nuevo para agregar un nuevo 
conjunto de resultados al archivo. Para quitar un conjunto de 
resultados, haga clic en el archivo seleccionado y pulse el botón 
Delete (Eliminar).  
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7. CÓMO CONFIGURAR LOGOS 

a. Seleccione Tools>Options (Herramientas>Opciones) del menú.  

b. La sección Logos especifica rutas de acceso a los archivos de logos a 
derecha e izquierda que se van a utilizar. 

c. Para cambiar el logo de la izquierda pulse el botón “…” por la ruta 
de acceso al logo de la izquierda. 

d. La pantalla Abrir le permite desplazarse hasta una ubicación de un 
archivo, seleccionar un archivo .JPG 0 .BMP, y pulsar el botón Open 
(Abrir). 

e. Repita los pasos (c) y (d) para la ruta de acceso del logo de la derecha. 

f. Obsérvese que no se mostrará un logo si la ruta de acceso al archivo 
del logo está en blanco o el archivo no existe. 

g. Obsérvese que luego de especificar los archivos de logo, la imagen no 
se mostrará sino hasta la próxima vez que se abra un formulario 
(File>Open o File>New en el menú (Archivo>Abrir, Archivo>Nuevo)). 

h. Obsérvese que los logos se verán de la mejor manera si la resolución 
del archivo es de 240 pixeles de ancho por 240 pixeles de alto. Los 
DPI no son importantes. 
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8. CÓMO CAMBIAR IDIOMAS 

a. Seleccione Tools>Options (Herramientas>Opciones) en el menú. 

b. Seleccione el idioma adecuado en el menú desplegable.  

 

9. CÓMO CAMBIAR UNIDADES DE MEDIDA 

a. Seleccione  Tools> Options (Herramientas>Opciones) en el menú. 

b. Seleccione las unidades en el menú desplegable Default Units (Unidades 
Predeterminadas) en Measurements (Mediciones). 

   



M 
 

 
AVTMMTO210-ES Rev 6 Mayo 2011 

56 

10. NOTAS COMPLEMENTARIAS 

a. Pueden completarse más formularios repitiendo los pasos 2, 3 y 6. 

b. Los formularios pueden imprimirse yendo a File>Print 
(Archivo>Imprimir) en el menú, o con CTRL+P, o pulsando el botón 
Print (Imprimir) de la barra de herramientas.  

c. En Help>PowerDB Lite Help del menú se encontrará una guía de 
ayuda. (Ayuda>Ayuda PowerDB Lite) 

Preguntas Frecuentes  

1. ¿Puedo cambiar los formularios? 

No. Para cambiar formularios debe tener la versión completa del PowerDB.  

2. ¿Puedo sincronizar formularios con una base de datos? 

No. Para asistencia con bases de datos y para sincronizar múltiples bases de 
datos in situ a una sola base de datos maestra debe tener la versión completa del 
PowerDB. 

3. ¿Puedo importar archivos del PowerDB Lite al PowerDB? 

Sí. Puede ir a File>Import (Archivo>Importar) en el menú del PowerDB para 
importar archivos desde el PowerDB Lite.  
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7 
Mantenimiento y Reparación 

Mantenimiento  
El mantenimiento deberá ser realizado sólo por personal calificado que conozcan los 
riesgos que implica el uso de equipos de prueba de alta tensión. Lea y comprenda la 
Sección 2, Seguridad, antes de realizar ninguna tarea de mantenimiento. 

El equipo de prueba MTO requiere mantenimiento de rutina. 

Con respecto a la apariencia exterior del equipo de prueba MTO, el mantenimiento 
consistirá en la limpieza periódica del estuche, el panel y los cables.      

1. Limpie el exterior del estuche para transporte del equipo con agua y 
detergente. Seque con un trapo limpio y seco. 

2. Limpie el panel de control con un trapo humedecido con agua y detergente. 
NO deje que el agua penetre por los orificios del panel, porque podría causar 
daño a los componentes del lado de abajo. Para limpiar el panel puede 
emplearse un limpiador doméstico multiuso en aerosol. Dé lustre con un 
trapo suave y seco, con cuidado de no rayar la cubierta de la pantalla. 

3. Limpie los cables y los correspondientes receptáculos del panel con alcohol 
isopropílico o desnaturalizado, aplicando con un trapo limpio. 

4. Revise ocasionalmente los cables para verificar que estén en buen estado. 

Reemplazo de Fusibles 

Los circuitos electrónicos del equipo de prueba MTO están protegidos por dos 
fusibles de la red eléctrica. Se indica el reemplazo de los fusibles si los circuitos 
electrónicos no funcionan. El reemplazo de los fusibles debe ser efectuado por 
personal calificado. A fin de evitar descargas eléctricas y riesgo de incendio, utilice 
solamente los fusibles que se especifican en la Sección 8, Lista de Piezas y Accesorios 
Opcionales, que son idénticos con respecto al tipo, tensión nominal y corriente 
nominal. Nótese que con cada MTO vienen 2 fusibles de repuesto.   

ADVERTENCIA 
Antes de reemplazar los fusibles, desconecte el 
cable de la alimentación eléctrica. 
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Para reemplazar el o los fusibles, proceda de la siguiente manera: 

1. Desconecte el cable de alimentación del equipo de prueba MTO. 

2. Con un destornillador pequeño de punta plana, retire cuidadosamente el 
portafusibles del módulo de alimentación instalado del lado derecho del 
panel frontal del aparato de prueba MTO. 

3. Retire y deshágase adecuadamente del o de los fusibles quemados. 

4. Instale el o los fusibles nuevos asegurándose de utilizar el tipo que se 
especifica en la Sección 8. 

5. Coloque nuevamente el portafusibles en su receptáculo, en el módulo de 
alimentación. Conecte el cable de alimentación al equipo de prueba MTO 
y a una fuente de alimentación con corriente. si los circuitos electrónicos 
siguen sin funcionar correctamente, comuníquese con la fábrica y solicite 
asistencia.   

 

Calibración 

Al menos una vez al año deberá realizarse una verificación completa de 
funcionamiento y calibración. Esto asegurará que el equipo de prueba MTO 
funcione y esté calibrado correctamente en toda la escala de medición. La 
calibración del MTO se efectúa en cada unidad nueva o reparada antes de 
enviarla a un cliente. Existe un procedimiento especial de calibración definitiva 
del MTO que requiere del uso de un equipo de prueba conforme a las normas 
del NIST. Como consecuencia de tal procedimiento de calibración, cada equipo 
de prueba MTO podrá ser certificado por el NIST (Instituto de Normas y 
Tecnología de los Estados Unidos).  
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Reparaciones 

Toda tarea de mantenimiento o reparación de este equipo deberá ser efectuada 
sólo por personal calificado que conozca los riesgos eléctricos y las precauciones 
necesarias para evitar lesiones. 

Megger ofrece un Servicio de Reparación y Calibración completo y recomienda 
que sus clientes aprovechen este servicio para realizar mantenimiento de rutina o 
en el caso de mal funcionamiento del equipo. 

En caso de requerirse una reparación, comuníquese con el representante de 
Megger de su zona y solicite un número de Autorización de Devolución (RA) del 
producto e instrucciones para el envío. 

Envíe el producto con porte pagado y asegurado e indique a la atención del 
Departamento de Reparaciones de Megger. Favor de indicar toda la información 
pertinente, incluido el número de catálogo, el número de serie y una descripción 
del problema.   
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CÓDIGOS DE ERROR 

El MTO viene con una amplia variedad de códigos de error que permiten 
verificar que la unidad esté funcionando correctamente y detectar problemas de 
manera sistemática. Cuando se produce un código de error, lo primero que hay 
que hacer es tomar conocimiento del error pulsando Enter y repitiendo la 
prueba. Si el error persiste, revise las posibles causas y determine si puede 
resolver el problema in situ. Si se descarta que sea la causa básica, comuníquese 
con Megger y solicite asistencia complementaria los códigos de error que se 
indican en negrita son bastante comunes debido a las posibles causas definidas. 

CÓDIGO Descripción del Error Posible Causa 

ESd El ESD está oprimido  El botón está oprimido, el cable interno 
está desconectado, falla de hardware 
interno 

IntLoc La interfaz de bloqueo está abierta Puente conector de bloqueo retirado, 
circuito de bloqueo asociado roto, cable 
interno desconectado 

1XX Errores de Ethernet y panel superior 
(sólo MTO210) 

 

101 No hay enlace entre el panel superior y la 
tarjetade adquisición de datos inferior 

 

102 Falla de comunicación Ethernet   

110 Error del interruptor selector de corriente  

111 Error del interruptor de Modo de Función  

112 Errores del interruptor de Modo de 
Almacenamiento 

 

113 Error BUS I2C  

114 Error bus I2C LCD   

115 Error bus I2C LED   

116 Error bus I2C MUX   

117 Falla de EEPROM  

2.0  Error de Inicialización   

201 Falla calibración interna del cero del ADC  
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CÓDIGO Descripción del Error Posible Causa 

(Conversor Analógico-Digital)  

202 Falla de calibración interna escala 
completa del ADC (Conversor Analógico-
Digital) 

 

203 Alimentación incorporada 5 volt fuera de 
los límites, demasiado alto 

 

204 Alimentación incorporada 10 volt fuera de 
los límites, demasiado alto 

 

205 Alimentación incorporada 28 volt fuera de 
los límites, demasiado alto 

 

206 Temperatura de alimentación eléctrica 
VICOR está fuera de los límites 

 

207 La temperatura del circuito de descarga 
está fuera de los límites 

 

208 La referencia 2,5V está fuera de los límites  

209 La referencia cero está fuera de los límites  

210 La referencia 25V está fuera de los límites  

211 Alimentación eléctrica VICOR, falla de 
regulación a 5 volts 

 

212 Alimentación eléctrica VICOR, falla de 
regulación a 20 volts 

 

213 Alimentación eléctrica VICOR, falla de 
regulación a 40 volts 

 

214 EsD  

215 Falla en circuito cerrado de control de 
alimentación eléctrica VICOR  

 

216 Demasiada fluctuación de tensión para la 
alimentación de 5 volt 

 

217 Demasiada fluctuación de tensión para la 
alimentación de 10 volt 
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CÓDIGO Descripción del Error Posible Causa 

218 Demasiada fluctuación de tensión para la 
alimentación de 28 volt 

 

221 Demasiada fluctuación de tensión para la 
referencia de 2,5 volts 

 

222 Demasiada fluctuación de tensión para la 
referencia de 25 volts 

 

223 Demasiada fluctuación de tensión para la 
alimentación eléctrica VICOR a 5 volts 

 

224 Demasiada fluctuación de tensión para la 
alimentación eléctrica VICOR a 20 volts 

 

225 Demasiada fluctuación de tensión para la 
alimentación eléctrica VICOR a 40 volts 

 

226 Falla entrada estado UNDER   

227 Falla entrada estado OVER   

228 Error de escritura bytes EEPROM  

229 Error de lectura bytes EEPROM   

230 La EEPROM no está inicializada  

231 Temperatura de descarga, demasiada 
fluctuación de corriente 

 

232 Tensión VNOISE fuera de los límites  

233 Demasiada fluctuación de tensión 
VNOISE  

 

234 Falla de alimentación eléctrica VICOR a 
5v, tensión demasiado alta 

 

235 Falla de alimentación eléctrica VICOR a 
5v, tensión demasiado baja 

 

236 Falla de alimentación eléctrica VICOR a 
20v, tensión demasiado alta 

 

237 Falla de alimentación eléctrica VICOR a 
20v, tensión demasiado baja 
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CÓDIGO Descripción del Error Posible Causa 

238 Falla de alimentación eléctrica VICOR a 
40v, tensión demasiado alta 

 

239 Falla de alimentación eléctrica VICOR a 
40v, tensión demasiado baja 

 

240 Falla de alimentación eléctrica VICOR en 
prueba en circuito cerrado, tensión 
demasiado baja 

 

241 Alimentación incorporada 10v fuera de los 
límites, tensión demasiado baja 

 

242 Alimentación incorporada 28v fuera de los 
límites, tensión demasiado baja 

 

243 La temperatura de descarga está fuera de 
los límites, demasiado alta 

Unidad sobrecalentada, filtros de 
ventiladores tapados, ventiladores no 
funcionan, exceso de uso, condiciones de 
prueba con temperatura sumamente 
elevada  

244 La temperatura de VICOR está fuera de 
los límites, demasiado alta 

Unidad sobrecalentada, filtros de 
ventiladores tapados, ventiladores no 
funcionan, exceso de uso, condiciones de 
prueba con temperatura sumamente 
elevada 

245 Tensión VNOISE fuera de los límites, 
demasiado baja 

 

246 Temperatura de VICOR, demasiada 
fluctuación de corriente 

 

3.0 ERROR_ADC  
(Conversor Analógico-Digital) 

 

301 Tiempos de lectura de ADC han expirado 
o ADC enclavado 

 

302 Error interno. Comunicación con ADC 
falló. 

 

303  Falla de configuración frecuencia de 
muestreo del ADC  

 

304  Falla de cal. interna cero ADC   
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CÓDIGO Descripción del Error Posible Causa 

305 Falla de cal. interna escala completa ADC  

306 El ADC no puede ser restablecido al 
modo normal 

 

307 Falla de selección canal 1 del ADC   

308 Falla de selección canal 2 del ADC  

309 Falla de selección canal 3 del ADC  

310 Demasiado ruido/fluctuación en lecturas 
del ADC 

 

311 Falla del ADC, inicialización  

312 Falla del ADC, tiempo de ejecución  

313 ADC bloqueado, no se puede leer  

314 Falla en canal 4 del ADC  

4.0 ERROR_HARDWARE  

401 La descarga tarda demasiado  

402 Falla de protección VICOR, OVER es 
demasiado largo o demasiado corto de 
restablecer 

 

403 Falla de protección VICOR, OVER es 
demasiado largo o demasiado corto de 
restablecer 

 

404 Falla de protección rápida de VICOR, 
OVER es demasiado largo o demasiado 
corto de restablecer 

 

405 Falla de protección rápida de VICOR, 
OVER es demasiado largo o demasiado 
corto de restablecer 

 

406 Falla de regulación de corriente a DAC=0  

407 Falla de regulación de corriente en el 
orden de 10mA 
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CÓDIGO Descripción del Error Posible Causa 

408 Falla de regulación de corriente en el 
orden de 100mA 

 

409 Falla de regulación de corriente en el 
orden de 1A 

 

410 Falla de regulación de corriente en la 
gama de 10A 

 

411 Salida de corriente no suficientemente alta  

412 Demasiada fluctuación para Lámpara 
Encendida (On) 

 

413 Demasiada fluctuación para Lámpara 
apagada (Off) 

 

414 La tensión de la lámpara de prueba es 
demasiado baja 

 

415 La tensión de la lámpara de prueba es 
demasiado alta 

 

416 Falla prueba de lámpara de advertencia  

417 Falla prueba de lámpara a distancia  

418 Falla prueba relé K1 activado y K2 
activado  

 

419 Falla prueba Relé K1 desactivado  

420 Falla prueba Relé K2 desactivado  

421 Falla prueba relé K3 activado y K4 
activado 

 

422 Falla prueba Relé K3 desactivado  

423 Falla prueba Relé K4 desactivado  

465 Falla de OVER y UNDER durante prueba 
de resistencia de arrollamientos 

 

466 Falla de calibración de corriente durante 
prueba de resistencia de arrollamientos 
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CÓDIGO Descripción del Error Posible Causa 

467 Falla de calibración de tensión durante 
prueba de resistencia de arrollamientos 

 

468 Señal de cancelación recibida  

469 Falla de calibración del cero del sistema 
durante la regulación de corriente 

 

470 No se ha establecido configuración de 
corriente para control de corriente. 

 

471 La corriente es plana o disminuye 
mientras se carga  

Conductores de corriente no conectados 

472 Error de corte antes de cierre Conductor retirado durante la prueba. 
Cambio de corriente >10% durante la 
prueba. 

473 Falla de H1+, falla de Vrelay3   

474 Falla de X3+, falla de K9  

475 Falla de I-SENSE  

476 Selección automática de escala, 
resistencia demasiado alta 

 

477 Selección automática de escala, falla de 
corriente 

 

478 Selección automática de escala, 
desviación estándar de corriente 
demasiado alta 

 

479 Selección automática de escala, la 
tensión es demasiado baja 

 

480 Corriente = 0  

481 OVER no permanecía fijado para la 
prueba normal de la protección de 
transistores 

 

482 OVER no permanecía fijado para la 
prueba rápida de la protección de 
transistores 

 

483 Falla protección de transistores media-  
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CÓDIGO Descripción del Error Posible Causa 

baja, OVER es demasiado corto para 
restablecer 

484 Falla protección de transistores media-
baja, OVER es demasiado corto para 
restablecer 

 

485 Falla protección rápida de transistores 
alta, OVER es demasiado corto para 
restablecer 

 

486 Falla protección rápida de transistores 
alta, OVER es demasiado largo para 
restablecer 

 

487 Falla protección rápida de transistores 
alta, OVER es demasiado corto para 
restablecer 

 

488 Falla de regulación de corriente en el 
orden de 10mA 

 

489 Falla de regulación de corriente en el 
orden de 100mA 

 

490 Falla de regulación de corriente en el 
orden de 1A 

 

491 Falla de regulación de corriente en la 
gama de 10A 

 

492 Falla relés K1 y K2, corriente demasiado 
baja 

 

493 Falla relés K3 y K4, corriente demasiado 
baja 

 

494 Señal de cancelación de ESD recibida Interruptor oprimido durante la prueba 
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8 
Lista de Piezas y Accesorios Opcionales 

Elemento N° de Cat. 

Ohmímetro para Transformadores 

120/230 volt, 50/60 Hz  

MTO210 

 

ACCESORIOS INCLUIDOS 

Juego cables de tensión V1, 18 m (60 ft)  2000-700  

Juego cables de tensión V2, 18 m (60 ft)  2000-701  

Juego cables de corriente, 18 m (60 ft)  2000-702  

Cable para puente, 9 m (30 ft) [1]  2000-703  

Conductor de puesta a tierra, 4.6 m (15 ft) [1]  4702-7  

Interruptor a distancia tipo gatillo  30915-220  

Cable de alimentación CA (IEC60320-C13 a norma USA)  17032  

Cable de alimentación CA (IEC60320-C13 a Schuko CEE 7/7)  17032-13  

Cable de Datos en Serie CA-RS232  

Guía de Arranque Rápido en la cubierta  37178  

Estuche de lona (para juego de cables)  30915-211  

Manual de instrucciones  ATVMMTO210  

Software PowerDB LITE  DB0001  

Fusible de 3,15A, 250V, 5x20mm, SLO BLOW  27708-7  

Fusible de 6,3A, 250V, 5x20mm, SLO BLOW  90001-167  

 

ACCESORIOS OPCIONALES 

 

Lámpara estroboscópica baliza  37181  

Impresora (incluye batería/impresora térmica en serie con 
alimentación de línea, cable de interfaz de impresora)  

   

120 V, 60 Hz  1001-390  

230 V, 50 Hz  1001-401  

Estuche de transporte con revestimiento de espuma  37009  

Software PowerDB (versión completa),1ª  licencia de máquina, 
tecla de función programable  

DB1001  

Software PowerDB (versión completa),1ª  licencia de máquina, 
llave electrónica (dongle) USB  

DB1001S  
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9 
Especificaciones 

ENTRADA 120/230 V, 50/60 Hz, 750 VA 

SALIDA  

Gamas de Corriente a selección  
del Usuario: 

hasta 10 mA 

 hasta 100 mA 

 hasta 1 A 

 hasta 10 A 

Tensión de Prueba: hasta 50 Vdc 

MEDICIÓN DE RESISTENCIA/PANTALLA  

Resistencia: @ 10A 1 μΩ a 2Ω  res. 0,1 uΩ 

@ 1.0A 10 μΩ a 20Ω  res. 1,0 uΩ 

@ 100mA 100 μΩ a 200Ω  res. 10 uΩ 

@ 10mA 1,0 mΩ a 2000Ω  res. 0,1 mΩ 

Exactitud: Lectura ±0,25%, escala completa ±0,25%  

Resolución: 4 dígitos 

Pantallas Dos LCD de 1’’ de alto, 6 caracteres, 7 segmentos 
Un LCD de 0,71” de alto, 6 caracteres, 7 segmentos 

IMPRESORA Vía puerto RS-232 

INTERFAZ DE USUARIO Pantallas numéricas blanco y negro, teclado numérico 

INTERFAZ DE COMPUTADORA 
(para descargar resultados) 

Vía puerto RS-232 

ALMACENAMIENTO INTERNO DE DATOS Hasta 2.000 conjuntos de datos (256 Kbytes) 

AMBIENTE  

Funcionamiento: -10° C a 50° C (14° F a 122° F) 

Almacenamiento: -15° C a +70° C (5° F a 158° F) 

Humedad Relativa: 0-90% sin condensación 

DIMENSIONES 216 mm alto x 546 mm ancho x 330 mm profundidad  
(8,5” alto x 21,5” ancho x 13” profundidad) 

PESO Neto 13,1 kg (29 lb) 
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